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Below is an extensive the List of Acronyms used in previous deliverables. Please add additional ones specific to this deliverable and delete unrelated ones. 

aisbl		Association International Sans But Lucratif 
 		(legal form of the PRACE-RI)
BCO		Benchmark Code Owner 
CoE		Center of Excellence 
CPU		Central Processing Unit
CUDA		Compute Unified Device Architecture (NVIDIA)
DARPA	Defense Advanced Research Projects Agency
DEISA	Distributed European Infrastructure for Supercomputing Applications EU project by leading national HPC centres
DoA		Description of Action (formerly known as DoW)
EC		European Commission
EESI		European Exascale Software Initiative
EoI		Expression of Interest
ESFRI	European Strategy Forum on Research Infrastructures 
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GÉANT	Collaboration between National Research and Education Networks to build a multi-gigabit pan-European network. The current EC-funded project as of 2015 is GN4.
GFlop/s	Giga (= 109) Floating point operations (usually in 64-bit, i.e. DP) per second, also GF/s
GHz		Giga (= 109) Hertz, frequency =109 periods or clock cycles per second
GPU		Graphic Processing Unit
HET	High Performance Computing in Europe Taskforce. Taskforce by representatives from European HPC community to shape the European HPC Research Infrastructure. Produced the scientific case and valuable groundwork for the PRACE project.
HMM		Hidden Markov Model
HPC	High Performance Computing; Computing at a high performance level at any given time; often used synonym with Supercomputing
HPL		High Performance LINPACK 
ISC	International Supercomputing Conference; European equivalent to the US based SCxx conference. Held annually in Germany.
KB		Kilo (= 210 ~103) Bytes (= 8 bits), also KByte
LINPACK	Software library for Linear Algebra
MB		Management Board (highest decision making body of the project)
MB		Mega (= 220 ~ 106) Bytes (= 8 bits), also MByte
MB/s		Mega (= 106) Bytes (= 8 bits) per second, also MByte/s
MFlop/s	Mega (= 106) Floating point operations (usually in 64-bit, i.e. DP) per second, also MF/s
MooC		Massively open online Course
MoU		Memorandum of Understanding.
MPI		Message Passing Interface
NDA	Non-Disclosure Agreement. Typically signed between vendors and customers working together on products prior to their general availability or announcement.
PA	Preparatory Access (to PRACE resources)
PATC	PRACE Advanced Training Centres
PRACE	Partnership for Advanced Computing in Europe; Project Acronym
PRACE 2	The upcoming next phase of the PRACE Research Infrastructure following the initial five year period.
PRIDE	Project Information and Dissemination Event
RI	Research Infrastructure
TB	Technical Board (group of Work Package leaders)
TB	Tera (= 240 ~ 1012) Bytes (= 8 bits), also TByte
TCO	Total Cost of Ownership. Includes recurring costs (e.g. personnel, power, cooling, maintenance) in addition to the purchase cost.
TDP	Thermal Design Power
TFlop/s	Tera (= 1012) Floating-point operations (usually in 64-bit, i.e. DP) per second, also TF/s
Tier-0	Denotes the apex of a conceptual pyramid of HPC systems. In this context the Supercomputing Research Infrastructure would host the Tier-0 systems; national or topical HPC centres would constitute Tier-1
UNICORE	Uniform Interface to Computing Resources. Grid software for seamless access to distributed resources.


[bookmark: _Toc249353267][bookmark: _Toc281213753][bookmark: _Toc319524529][bookmark: _Toc412817324][bookmark: _Toc427677887][bookmark: _Toc429580664]List of Project Partner Acronyms
BADW-LRZ	Leibniz-Rechenzentrum der Bayerischen Akademie der Wissenschaften, Germany (3rd Party to GCS)
BILKENT	Bilkent University, Turkey (3rd Party to UYBHM)
BSC	Barcelona Supercomputing Center - Centro Nacional de Supercomputacion, Spain 
CaSToRC		Computation-based Science and Technology Research Center, Cyprus
CCSAS	Computing Centre of the Slovak Academy of Sciences, Slovakia
CEA	Commissariat à l’Energie Atomique et aux Energies Alternatives, France (3 rd Party to GENCI)
CESGA	Fundacion Publica Gallega Centro Tecnológico de Supercomputación de Galicia, Spain, (3rd Party to BSC)
CINECA	CINECA Consorzio Interuniversitario, Italy
CINES	Centre Informatique National de l’Enseignement Supérieur, France (3 rd Party to GENCI)
CNRS	Centre National de la Recherche Scientifique, France (3 rd Party to GENCI)
CSC	CSC Scientific Computing Ltd., Finland
CSIC	Spanish Council for Scientific Research (3rd Party to BSC)
CYFRONET	Academic Computing Centre CYFRONET AGH, Poland (3rd party to PNSC)
EPCC	EPCC at The University of Edinburgh, UK 
ETHZurich (CSCS)	Eidgenössische Technische Hochschule Zürich – CSCS, Switzerland
FIS		FACULTY OF INFORMATION STUDIES, Slovenia (3rd Party to ULFME)
GCS	Gauss Centre for Supercomputing e.V.
GENCI	Grand Equipement National de Calcul Intensiv, France
GRNET	Greek Research and Technology Network, Greece
INRIA	Institut National de Recherche en Informatique et Automatique, France (3 rd Party to GENCI)
IST	Instituto Superior Técnico, Portugal (3rd Party to UC-LCA)
IUCC	INTER UNIVERSITY COMPUTATION CENTRE, Israel
JKU	Institut fuer Graphische und Parallele Datenverarbeitung der Johannes Kepler Universitaet Linz, Austria
JUELICH	Forschungszentrum Juelich GmbH, Germany
KTH	Royal Institute of Technology, Sweden (3 rd Party to SNIC)
LiU	Linkoping University, Sweden (3 rd Party to SNIC)
NCSA	NATIONAL CENTRE FOR SUPERCOMPUTING APPLICATIONS, Bulgaria
NIIF		National Information Infrastructure Development Institute, Hungary
NTNU	The Norwegian University of Science and Technology, Norway (3rd Party to SIGMA)
NUI-Galway	National University of Ireland Galway, Ireland
PRACE	Partnership for Advanced Computing in Europe aisbl, Belgium
PSNC	Poznan Supercomputing and Networking Center, Poland
RISCSW	RISC Software GmbH
RZG	Max Planck Gesellschaft zur Förderung der Wissenschaften e.V., Germany (3 rd Party to GCS)
SIGMA2	UNINETT Sigma2 AS, Norway
SNIC	Swedish National Infrastructure for Computing (within the Swedish Science Council), Sweden
STFC		Science and Technology Facilities Council, UK (3rd Party to EPSRC)
SURFsara	Dutch national high-performance computing and e-Science support center, part of the SURF cooperative, Netherlands
UC-LCA	Universidade de Coimbra, Labotatório de Computação Avançada, Portugal
UCPH	Københavns Universitet, Denmark
UHEM	Istanbul Technical University, Ayazaga Campus, Turkey
UiO	University of Oslo, Norway (3rd Party to SIGMA)
ULFME	UNIVERZA V LJUBLJANI, Slovenia
UmU	Umea University, Sweden (3 rd Party to SNIC)
UnivEvora	Universidade de Évora, Portugal (3rd Party to UC-LCA)
UPC	Universitat Politècnica de Catalunya, Spain (3rd Party to BSC)
UPM/CeSViMa	Madrid Supercomputing and Visualization Center, Spain (3rd Party to BSC)
USTUTT-HLRS	Universitaet Stuttgart – HLRS, Germany (3rd Party to GCS)
VSB-TUO	VYSOKA SKOLA BANSKA - TECHNICKA UNIVERZITA OSTRAVA, Czech Republic
WCNS	Politechnika Wroclawska, Poland (3rd party to PNSC)
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[bookmark: _Toc75287376][bookmark: _Toc194478747][bookmark: _Toc376680009][bookmark: _Toc429580665]Executive Summary
Summarize the objectives and key results of the deliverable. 
PRACE deliverables document the work performed according to the Description of Action (Annex I to the Grant Agreement). All deliverables follow a consistent structure and layout. This prototype document describes in detail the conventions that the authors should adhere to. It is written as if it were a real deliverable. Delete the text in this deliverable bur retain the formatting.
The description of the work should be as concise as possible. It should also be explicit and state the results clearly. The external reviewers do not appreciate if they have to read ‘between the lines’. The combination of clear message, well written text – without spelling and grammatical errors – and a pleasing layout are as important for the acceptance of the project achievements by the reviewers and the EC as the actual work.
The Executive Summary should be less than one page. It should start on ‘Page 1’ and on the top page of the sheet.
[bookmark: _Toc75287375][bookmark: _Toc194478748][bookmark: _Toc376680010][bookmark: _Toc429580666]Introduction
Provide a brief description of the following (if appropriate):
· Objectives of the work related to the project as a whole;
· Purpose of the document;
· Structure of the document (what is in the different sections/chapters);
· Intended audience.
· … 
The Deliverable Template provides a consistent structure for all PRACE project deliverables. It is intended to minimise the work of the author by letting them concentrate of the contents and not waste time on formatting and layout. Text in Italics is Meta Text and must be removed. 
Section 2 (Note: This is a relative reference to the respective chapter –do not use absolute numbers!) describes the general formatting convention like fonts, font size, and spacing for text, paragraphs, bullet lists, and headings. Section 3 gives examples how to include figures and figure subscripts that will automatically be included in the list of figures. Section 4 gives examples how to include tables and table subscripts that will automatically be included in the list of tables. Section 5 explains the text fields that are used in this document and hints how to avoid destroying them. Finally, Section 6 provides general hints and solutions to known problems. Section 7 is an example of landscaper formatted pages that may become necessary if wider tables are included. Annex 8.3 describes how pdf documents can be included as images.
The structure of this template follows the description given above. The headings corresponding to this description are given in parentheses after the generic titles. 
This document is intended for the authors of PRACE deliverables. Each contributor should also use the template to make the task of consolidating inputs as easy as possible for the authors. 
The easiest way is to delete the template specific text and overwrite the ‘<Text begins here>’ with the deliverable specific text.
This version of the template highlights points which often result in formatting errors in yellow.
[bookmark: _Toc75287380][bookmark: _Toc194478749][bookmark: _Ref269816026][bookmark: _Ref269816053][bookmark: _Ref269816064][bookmark: _Ref269816098][bookmark: _Toc376680011][bookmark: _Toc429580667]Section Title (General Formatting Conventions)
<Text begins here.>
The document is prepared using Word2010. It can be used with Word2007 provided the converter is installed in Word2007. However, flexible placement of figures as described in 3.2 will not work for older versions of Word like Word2003. Usage of other Word Processing software created problems even if they have a function ‘Save as Word2010’ or similar. It is the responsibility to ensure (prior to submission for internal review) that the document can be read without problems in Word2010 and that a correctly formatted pdf file can be produced. If in doubt, contact PMO.
[bookmark: _Ref194465939][bookmark: _Toc194478750][bookmark: _Toc376680012][bookmark: _Toc429580668]Section Title Level 1 (Formatting of Paragraphs)
<Text begins here> 
The font for general text is ‘Times New Roman’, 12pt, single spaced. Use Bold Face or Italics to highlight as appropriate – but sparingly. Code samples or output of programs use either Arial or fixed spaced Courier – as appropriate.
[bookmark: _Toc194478751][bookmark: _Toc376680013][bookmark: _Toc429580669]Section Title Level 2 (Block Setting)
<Text begins here>. 
Paragraphs are ‘block set’, i.e. they are flush left and right. This paragraph is correctly formatted. It contains three lines the first two are flush right. The last one is not spread across the line (as one would expect).
This paragraph contains imported text from a different source, e.g. an ASCII file.  This potentially results in extra spaces especially at the beginning of a new sentence.  Remove them.  They will distort the picture.  Note that left-justified text looks odd.
This paragraph contains imported text from a different source, e.g. an ASCII file.  This potentially results in extra spaces especially at the beginning of a new sentence.  Remove them.  They will distort the picture.
[bookmark: _Toc194478752][bookmark: _Toc376680014][bookmark: _Toc429580670]Section Title Level 2 (Space before and after)
<Text begins here>
The default formatting of paragraphs is 0pt before and 6pt after each paragraph. Do not use an empty line to separate paragraphs. This gives too much blank space.
[bookmark: _Toc194478753][bookmark: _Toc376680015][bookmark: _Toc429580671]Section Title Level 1 (Formatting of Lists)
<Text begins here.>
If possible use only Bullet lists of one or two levels and numbered lists of one level. If you have to deviate from the proposed ‘standard’ make sure you use the same bullets throughout the document.
[bookmark: _Toc194478754][bookmark: _Toc376680016][bookmark: _Toc429580672]Section Title Level 2 (Bullet Lists)
<Text begins here>
· This is line one of the bullet list. It can span more than one line. Please note that block formatting also applies. 
· This is line two of the bullet list. It can span more than one line. Please note that block formatting also applies. 
· This is sub-bullet line 1. It can span more than one line. Please note that block formatting also applies.
· This is sub-bullet line 2.
· This is line three of the bullet list. It can span more than one line. Please note that block formatting also applies. 
The default formatting of bullet list paragraphs is 0pt before and 3pt after each paragraph.
[bookmark: _Toc376680017][bookmark: _Toc429580673]Section Title Level 2 (Numbered Lists)
<Text begins here>
1. This is line one of the bullet list. It can span more than one line. Please note that block formatting also applies. 
2. This is line two of the bullet list. It can span more than one line. Please note that block formatting also applies. 
a) This is sub-bullet line 1. It can span more than one line. Please note that block formatting also applies. Use it sparingly - if at all.
b) This is sub-bullet line 2.
3. This is line three of the bullet list. It can span more than one line. Please note that block formatting also applies. 
The default formatting of bullet list paragraphs is 0pt before and 3pt after each paragraph.
[bookmark: _Toc194478755][bookmark: _Toc376680018][bookmark: _Toc429580674]Section Title – Level 1 (Headings) 
<Text begins here>. 
Three levels of headings are defined and automatically included in the Table of Contents (ToC). All (except the ‘Executive Summary’) are numbered and left justified. The Executive Summary is centred.
Level 1 is formatted as Arial, bold face, 14pt with 18pt before and 18pt after and numbered 1, 2, ….
Level 2 is formatted as Arial, bold face, 12pt with 18pt before and 12pt after and numbered 1.1, 1.2, …, 2.1, 2.2, ….
Level 3 is formatted as Arial, italics, 12pt with 12pt before and 12pt after and numbered 1.1.1, 1.1.2, …, 2.1.1, 2.1.2, ….
It might be appropriate to start a new section on a new page to better structure the document, especially, when the new section starts at the very bottom of the page. A manual page break might be inserted at the final stage of the production. This is the case in this template to start Section 2: Section Title (General Formatting Conventions) on page 2.
[bookmark: _Toc194478756][bookmark: _Ref300578409][bookmark: _Toc376680019][bookmark: _Toc429580675]Section Title (Figures)
<Text begins here.>
This section shows examples how figures can be inserted into the text and how it is insured that the figure subscript is properly included into the List of Figures. 
[bookmark: _Toc194478757][bookmark: _Toc376680020][bookmark: _Toc429580676]Section Title – Level 1 (Simple Graphic In Line)
<Text begins here>
[image: PRACE_Logo_pos_CMYKeps]
[bookmark: _Ref269049680][bookmark: _Ref269049106][bookmark: _Toc332803147]Figure 1: The PRACE logo inserted with text 
Inserting figures at a line break works in Word2010. The figures are always left-justified. The description of the figure (e.g. Figure 1: The PRACE logo inserted with text) can be generated by right clicking on the Figure and selecting ‘Insert Caption’ (or the equivalent in the national language that Word is using) and place the caption below the Figure. Enter the title, numbering is automatic. All references to figures within the text must be through cross references (Select: Insert > References > Figure). This ensures that the numbering will remain correct, even if figures are deleted or inserted. Do not use absolute numbers (you will pay for this later!).
[bookmark: _Ref269815666][bookmark: _Toc376680021][bookmark: _Toc429580677]Section Title – Level 1 (Graphic on Page)
[image: F:\1IP\Presentations\prace_countries.jpg]This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text. This is a sample text to show the positioning of figures in the text.[bookmark: _Ref269049691][bookmark: _Toc332803148]Figure 2: This is floating text around the figure with a very long figure subscript that extends over more than one line in the List of Figures (avoid if possible)

In Word2010 you may select the position of the figure anywhere on the page and add figure subscripts that are correctly included in the List of Figures. This feature does not work when you maintain compatibility with Word2003 or in a native Word2003 document. 
You can load a Word2010 (.docx) document containing figures like the one in Figure 1 into Word2003 (if you have the converter installed) and view it. However, this figure will not appear in the List of Figures. 
Historic note: In the older versions of Word there is a feature called Position Frame that supports this. This is a terrible nuisance, since the figures tend to jump on the page whenever text is added or deleted. 
Hint: Use concise Figure (and Table) captions. The full explanation should be in the text. The negative effect can be seen in above example. The Figure subscript overlays part of the footer and produces a cluttered List of Figures.
[bookmark: _Ref300578424][bookmark: _Toc376680022][bookmark: _Toc429580678]Section Title (Tables)
<Text begins here.>
This section shows examples how tables can be inserted into the document and how it is insured that the table subscript is properly included into the List of Tables. 
Tables must explicitly be referred to in the text. Tables without a reference are useless and should be removed. Caption for tables appears below the table. See for example: Table 1: Sample table with five columns.
	Number
	Name1
	Name2
	Name3
	Name4

	1
	
	
	
	

	2
	
	
	
	

	3
	
	
	
	

	4
	
	
	
	

	6
	
	
	
	

	7
	
	
	
	

	8
	
	
	
	


[bookmark: _Ref269050623][bookmark: _Toc332789992]Table 1: Sample table with five columns

Always use references to point to tables. Never use absolute numbers. 

	Number
	Header1
	Header2
	Header3

	1
	
	
	

	2
	
	
	

	3
	
	
	

	4
	
	
	

	5
	
	
	

	6
	
	
	

	7
	
	
	

	8
	
	
	

	9
	
	
	

	10
	
	
	

	11
	
	
	

	12
	
	
	

	13
	
	
	

	14
	
	
	

	15
	
	
	

	16
	
	
	

	17
	
	
	

	18
	
	
	

	19
	
	
	

	20
	
	
	

	21
	
	
	

	22
	
	
	

	23
	
	
	

	24
	
	
	

	25
	
	
	

	26
	
	
	

	27
	
	
	

	28
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc332789993]Table 2: Long Table spanning more than one page

If the table does not fit on a page, make sure that the header line is repeated. Mark the header line and the right click and select table properties’ and select ‘repeat header line’.
[bookmark: _Ref300578433][bookmark: _Toc376680023][bookmark: _Toc429580679]Section Title (Text Fields)
Certain data items, like the project acronym or the title appear in several places in the document, e.g. in the header and footer lines. To avoid updating them in each individual place, they have been defined as text fields on the title page. Change the text fields only on the title page. The changed value will appear where ever it is referenced. (Depending on global Word options, the updates become visible only after previewing or printing the documents or if you explicitly select ‘Update Fields’.)
The following fields are defined:
	Text field name
	Current value

	DeliverableNumber
	Dx.y

	DeliverableTitle
	Full Title of the Deliverable Do not Destroy this Text Field

	Acronym
	PRACE-4IP

	ReferenceNumber
	EINFRA-653838

	PrepDate
	01.03.2017

	Version
	x.x

	Author
	NN, Organisation

	Status
	Draft/Final


[bookmark: _Ref300579711][bookmark: _Ref300579701][bookmark: _Toc332789994]Table 3: List of Text Fields

The actual values from the title pages are shown here. As a test change one of them on the title page and check how it is changes in column 2 of Table 3.
The fact that the text on the title page is actually a text field is normally well hidden. To make it visible, click on the round Word button top left and Select Word Options > Extended > Show Text Markers. 
The effect will be that the text fields are shown in grey brackets (see Figure 3): 
[image: ]
[bookmark: _Ref300309443][bookmark: _Ref332801960][bookmark: _Toc332803149]Figure 3: Title page with Text Fields
	
When changing the text, make sure that you stay within the brackets.
Select also: Show all formatting to see line breaks, spaces, tabs, etc. on the screen.
Note: Figure 3 is a screen shot of the title page of this document in jpg format. The Frame around it was added in Word.
[bookmark: _Ref300578466][bookmark: _Toc376680024][bookmark: _Toc429580680]Section Title (General Hints)
When you display or print a document, Word does not always update all references (numbering of figures, updates of page numbers in the ToC and elsewhere) depending on global settings. To be sure everything is correct force the update manually: Press CTRL-a, right click and select update references. 
You might be prompted several times for the Table of Contents (ToC), the List of Figures, and the List of Tables. Select update references at least once. If the ToC is correct, you may use Update Page Numbers. 
Please verify that text or figures are formatted correctly by re-creating the Table of Contents (right click  update references). This will reveal if parts of the document are inadvertently formatted as headings. 
When different authors contribute to the final deliverables, instruct them to adhere to the conventions described here, especially to use relative references to figures and tables. This will save time for everybody.


[bookmark: _Ref300578510][bookmark: _Toc376680025][bookmark: _Toc429580681][bookmark: _Toc75287384][bookmark: _Toc194478758]Section Formatted as Landscape
This page is formatted as landscape for example to include a wide table. This is facilitated in Word by starting a new Section. To insure that headers and footers are left/right justified correctly, they must NOT be linked to the previous section. See the Word Help for this advanced feature.
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[bookmark: _Toc332789995]Table 4: Wide Table

The headers and footer of the following Portrait section are again NOT linked to this one. 
When you delete this Section make sure that the headers and footers of the next section are linked again to previous one.
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[bookmark: _Toc376680026][bookmark: _Toc429580682]Annex
Annexes are optional but if included they form an integral part of the PRACE project report.
<Text begins here.>
[bookmark: _Toc75287385][bookmark: _Toc194478759][bookmark: _Toc376680027][bookmark: _Toc429580683][bookmark: _Toc494089556][bookmark: _Toc511460746]Annex Title – Level 1
<Text begins here>
[bookmark: _Toc194478760][bookmark: _Toc376680028][bookmark: _Toc429580684]Annex Title – Level 1
<Text begins here> 
[bookmark: _Ref300578589][bookmark: _Toc376680029][bookmark: _Toc429580685]Notes on appending Documents originating from PDF files
(Instructions courtesy Axel Auweter, LRZ)
It is often the case that one wants to append documents from third parties in the Annex section. If these documents are provided as PDF documents, including them to the deliverable while retaining the overall layout can be a tricky task. A working solution is to include the contents of the original document as image files on a page-by-page basis. Therefore, including an external document works in two steps:
· Step 1: Create image files from the original PDF file
· Step 2: Insert the image files to the deliverable
Please note that the EC only accepts PDF files smaller than 10MB. Since including external documents as images occupies quite some disk space, make sure that the final document does not exceed that limit.
Step 1: Creating image files from the original PDF file
[image: ]
[bookmark: _Toc332803150]Figure 4: Creating an Image file from pdf
There are multiple options to achieve this. The easiest is to use Adobe Acrobat (you need the Pro version; the free Adobe Reader is not enough). In the File menu select Export/Image. This will create you one image per page in the selected graphics format.
If you do not have access to Adobe Acrobat, you can also do the conversion using the free ImageMagick set of command line utilities:
convert –density <DPI> input.pdf output-pages-%03d.png
Replace <DPI> with the desired image resolution (e.g. 600).
Step 2: Insert the image files into the deliverable
From the Insert Tab, choose Picture. A file dialog opens. Make sure to have the files showing in ascending order. Select (single click) the last (!) file that you want to insert. Then press the Shift key on your keyboard and hold it while you click on the first file that you want to insert.
You should see a screen that looks like this with all files showing in the right order at the bottom of the dialog window:
[image: ]
[bookmark: _Toc332803151]Figure 5: Inserting image files

[bookmark: _GoBack]If you click on “Insert”, your images will be inserted into the document in the right order at a suitable size automatically.
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